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เพื่อการน าเสนอข้อมูลอุตุนิยมวิทยา 
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ศูนย์อุตุนิยมวิทยาภาคตะวันออกเฉียงเหนือตอนบน 

 



 

ค าน า 

  

 ระบบสารสนเทศภูมิศาสตร์ (Geographic Information System : GIS) เป็นวิธีการและเครื่องมือที่
น าเอาระบบกราฟิกแผนที่ (Geographic) มาท างานร่วมกับระบบฐานข้อมูล (database) ให้กลายเป็นข้อมูลเชิง
พ้ืนที่ (Spatial Data) ที่สามารถใช้ในการจัดเก็บ แก้ไข ปรับปรุง สืบค้น จัดการ วิเคราะห์ แสดงผล และรายงาน
ผลข้อมูลเชิงพ้ืนที่ด้วยระบบคอมพิว เตอร์ ศูนย์อุตุนิยมวิทยาภาคตะวันออกเฉียงเหนือตอนบนจึงได้น าระบบ  
สารสนเทศภูมิศาสตร์ (GIS) มาประยุกต์ใช้ในการน าเสนอข้อมูลสารสนเทศอุตุนิยมวิทยาในรูปแบบเชิงพ้ืนที่ เพ่ือ
ปรับปรุงและพัฒนาการน าเสนอข่าวพยากรณ์อากาศ และข้อมูลอุตุนิยมวิทยาให้เป็นรูปแบบกราฟฟิก  ให้ง่า ยต่อ
การเข้าใจของประชาชนผู้รับบริการ 

  คู่มือการประยุกต์ใช้ระบบสารสนเทศภูมิศาสตร์ (GIS) เพ่ือการน าเสนอข้อมูลอุตุนิยมวิทยา เล่มนี้เป็น
การรวบรวมความรู้พ้ืนฐานของระบบสารสนเทศภูมิศาสตร์ (GIS) การจัดการแผนที่เวคเตอร์ การใช้โปรแกรม 
Arcgis 10.1 เพ่ือวิเคราะห์ข้อมู ลเชิงพ้ืนที่โดยวิธีการประมาณค่า ช่วง (Interpolation) การวิเคราะห์ข้อมูล
อุตุนิยมวิทยาด้วยโปรแกรม Surfer 10 การประยุกต์ใช้โปรแกรม Arcgis 10.1 เพ่ือการพยากรณ์โอกาสการเกิดฝน
หรือฝนฟ้าคะนองบริเวณภาคตะวันออกเฉียงเหนือตอนบน และการจัดท า Layout เพ่ือการน าเสนอ 
คณะกรรมการจัดการความรู้หวังว่าคู่มือเล่มนี้จะเป็นประโยชน์กับผู้ใช้ในการน าไปประยุกต์ใช้ในการจัดท าแผนที่
ข้อมูลอุตุนิยมวิทยาเชิงพ้ืนที่ในการน าเสนอต่อไป 
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  1. ความรู้พื้นฐานระบบสารสนเทศภูมิศาสตร์ (GIS) 

  

 

 

                    เทคโนโลยีภูมิสารสนเทศ (Geo – Informatic/Geomatics) 

 เทคโนโลยีภูมิสารสนเทศ (Geo – Informatic/Geomatics) เป็นศาสตร์และศิลป์ที่เก่ียวข้องกับ 
ข้อมูลเชิงพ้ืนที่ ซึ่งสามารถระบุต าแหน่งอ้างอิงบนพื้นผิวโลก (Geospatial data) ได้ ประกอบด้วยเทคโนโลยี 3S 
คือ RS, GPS และ GIS คือ 
  1. ระบบสารสนเทศภูมิศาสตร์ (Geographic Information System ) : GIS 
  2. การรับรู้จากระยะไกล (Remote Sensing) : RS 
  3. ระบบก าหนดต าแหน่งบนโลก  Global Positioning System : GPS 
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1.ความหมายของระบบสารสนเทศภูมิศาสตร์ 
   ระบบสารสนเทศภูมิศาสตร์ (Geographic Information System: GIS) หมายถึง เครื่องมือที่ใช้
ระบบคอมพิวเตอร์ เพ่ือช่วยในการน าเข้า จัดเก็บ จัดเตรียม ดัดแปลง แก้ไข จัดการ และวิเคราะห์ พร้อมทั้ง
แสดงผลข้อมูลเชิงพ้ืนที่ ตามวัตถุประสงค์ต่างๆ ที่ก าหนดไว้ ดังนั้น GIS จึงเป็นเครื่องมือที่มีประโยชน์เพื่อใช้ในการ
จัดการ และบริหารการใช้ทรัพยากรธรรมชาติและสิ่งแวดล้อมและสามารถติดตามการเปลี่ยนแปลงข้อมูลด้านพื้นที่ 
ให้เป็นไปอย่างมีประสิทธิภาพ เนื่องจากเป็นระบบท่ีเกี่ยวข้องกับระบบการไหลเวียนของข้อมูล และการผสมผสาน
ข้อมูลจากแหล่งต่างๆ เช่น ข้อมูลปฐมภูมิ (Primary Data) หรือข้อมูลทุติยภูมิ (Secondary Data) เพ่ือให้ได้
สารสนเทศที่มีคุณค่าและสามารถน าไปใช้ในการบริหารจัดการได้อย่างมีประสิทธิภาพ 
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2.องค์ประกอบของระบบสารสนเทศภูมิศาสตร์ 

 ระบบสารสนเทศภูมิศาสตร์ มีองค์ประกอบที่ส าคัญอยู่ 5 ส่วน คือ ข้อมูล/สารสนเทศ 
(Data/Information), เครื่องคอมพิวเตอร์และอุปกรณ์ต่างๆ (Hardware), โปรแกรม (Software), และบุคลากร 
(User/People), และข้ันตอนการท างาน (Process) 
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2.1 ข้อมูล (Data/Information)  

 ข้อมูลที่จะน าเข้าสู่ระบบสารสนเทศภูมิศา สตร์ควรเป็นข้อมูลเฉพาะเรื่อง (Theme) และเป็นข้อมูลที่
สามารถน าไปใช้ในการตอบค าถามต่างๆ ได้ตรงตามวัตถุประสงค์ เป็นข้อมูลที่มีความถูกต้องและเชื่อถือได้ และ
เป็นปัจจุบันมากที่สุด โดยข้อมูลในระบบสารสนเทศภูมิศาสตร์แบ่งออกได้เป็น 2 ประเภท คือ ข้อมูลเชิงพ้ืนที่ 
(Spatial Data) และข้อมูลอธิบาย (non-Spatial Data or Attribute Data) 

 ข้อมูลเชิงพ้ืนที่ (Spatial Data) เป็นข้อมูลที่แสดงต าแหน่งที่ตั้งทางภูมิศาสตร์ (Geo-Reference Data) 
ของรูปลักษณ์ของพ้ืนที่  (Graphic Feature) ซึ่งมีอยู่ 2 แบบ คือ ข้อมูลที่แสดงทิศทาง (Vector Data) และข้อมูล
ที่แสดงเป็นตารางกริด (Raster Data) โดยข้อมูลที่มีทิศทาง ประกอบด้วยลักษณะ 3 อย่าง คือ 

- ข้อมูลจุด (Point) เช่น ที่ตั้งหมู่บ้าน โรงเรียน หรือวัดเป็นต้น 
- ข้อมูลเส้น (Line) เช่น ถนน แม่น้ า เป็นต้น 
- ข้อมูลพื้นที่ หรือเส้นรอบรูป (Polygon) เช่น แหล่งน้ าผิวดิน เป็นต้น 
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2.2 เครื่องคอมพิวเตอร์และอุปกรณ์ต่างๆ  

เครื่องคอมพิวเตอร์ รวมกันเรียกว่า ระบบฮาร์ดแวร์  (Hardware) จะประกอบด้วย คอมพิวเตอร์ อุปกรณ์
การน าเข้า เช่น Digitizer, Scanner, Global Positioning System (GPS), อุปกรณ์อ่านข้อมูล เก็บรักษาข้อมูล 
และแสดงผลข้อมูล เช่น Printer Plotter เป็นต้น ซึ่งอุปกรณ์แต่ละชนิดจะมีหน้าที่และคุณภาพแตกต่างกันออกไป 

                                   

 

2.3 โปรแกรมหรือซอฟต์แวร์ (Software) 
       Software หมายถึง โปรแกรมท่ีใช้ในการจัดการระบบ และสั่งงานต่างๆ เพื่อให้ระบบฮาร์ดแวร์
ท างาน หรือเรียกใช้ข้อมูล ที่จัดเก็บในระบบฐานข้อมูลมาท างานตามวัตถุประสงค์ โดยทั่วไปชุดค าสั่งหรือโปรแกรม
ของระบบสารสนเทศภูมิศาสตร์ จะประกอบด้วย หน่วยน าเข้าข้อมูล หน่วยเก็บข้อมูลและการจัดการข้อมูล หน่วย
วิเคราะห์ หน่วยแปลงข้อมูล หน่วยแสดงผลและหน่วยตอบโต้กับผู้ใช้ (User Interface) 

2.4 บุคลากร (Human Resource) 
  บุคลากร จะประกอบด้วยนักวิเคราะห์หรือสร้างระบบ (Analyst) และผู้ใช้สารสนเทศ (User) โดย
ผู้ใช้ระบบหรือผู้ช านาญการ GIS จะต้องมีความช านาญในหน้าที่ และได้รับการฝึกฝนมาแล้วเป็นอย่างดี พร้อมที่จะ
ท างานได้เต็มความสามารถ โดยทั่วไปผู้ใช้ระบบจะเป็นผู้เลือกระบบฮาร์ดแวร์และซอฟต์แวร์ เพื่อให้ตรงตาม
วัตถุประสงค์ และสนองตอบความต้องการของหน่วยงาน ส่วนผู้ใช้สารสนเทศ (User) คือนักวางแผน หรือผู้มี
อ านาจตัดสินใจ (Decision-maker) เพ่ือน า 
ข้อมูลมาใช้ในการแก้ไขปัญหาต่างๆ 

2.5 ขั้นตอนการด าเนินงาน (Procedure) 

ในระบบสารสนเทศภูมิศาสตร์ ความถูกต้องของข้อมูลเป็นสิ่งส าคัญที่สุด เพราะการวิเคราะห์และตัดสินใจ
จากข้อมูลที่ผิดพลาดสามารถจะท าให้เกิดผลเสียอย่างใหญ่หลวง ทั้งแรงงาน ความพยายาม และค่าใช้จ่ายทุกอย่าง
ที่ลงทุนไปจะกล ายเป็นความสูญเปล่า ในการสร้างฐานข้อมูลที่ดีจึงต้องมีขั้นตอนการท างานที่ละเอียดถูกต้อง 
เพ่ือให้เป็นการประหยัด ฐานข้อมูลควรได้รับการออกแบบโดยค านึงถึงเป้าหมายให้สามารถใช้ร่วมกันได้ในกิจกรรม
หลากหลาย 
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3. ระบบพิกัด (Coordinate System) 

  โลกของเราประกอบด้ว ยข้อมูลจ านวนมหาศาลทั้งสิ่งมีชีวิตและไม่มีชีวิต การจ าแนกประเภทและ
ก าหนดต าแหน่งพิกัด (coordinate) ของแต่ละประเภท ท าโดยการย่อส่วนของสิ่งต่าง ๆ บนพื้นโลกลงในกระดาษ
แผนที่ เช่น แผนที่โลก แผนที่ประเทศ แผนที่จังหวัด อ าเภอ ต าบล และหมู่บ้าน แผนที่ถนน แหล่งน้ า ป่าไม้ เป็น
ต้น ซึ่งแผนที่กระดาษเหล่านี้จะใช้มาตราส่วนการย่อส่วน (scale) แตกต่างกัน ขึ้นอยู่กับขนาดพื้นที่ ในระบบ
สารสนเทศภูมิศาสตร์จะน าแผนที่เหล่านี้เก็บเข้าเครื่องคอมพิวเตอร์อย่างเป็นระบบ  

 

 โลกของเรามีรูปร่างลักษณะเป็นรูปทรงรี (Oblate Ellipsoid) คือ มีลักษณะป่องตรงกลาง ขั้วเหนือ 
– ใต้ แบนเล็กน้อย แต่ผิวโลกที่แท้จริงมีลักษณะขรุขระ สูง ต่ า ไม่ราบเรียบ สม่ าเสมอ พื้นผิวโลกจะมีพ้ืนที่
ประมาณ 509,450.00 ตารางกิโลเมตร มีเส้นผ่าศูนย์กลางที่ศูนย์สูตรยาว 12,757 กิโลเมตร มีเส้นผ่าศูนย์กลาง
จากข้ัวโลกเหนือถึงขั้วโลกใต้ 12,714 กิโลเมตร จะเห็นว่าระยะทางระหว่างแนวนอน (เส้นศูนย์สูตร ) ยาวกว่า
แนวตั้ง (ขั้วโลกเหนือ-ใต้)  
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  จากลักษณะรูปทรงของโลก ท าให้ไม่สามารถใช้รูปทรงเรขาคณิตอย่างง่ายในการแสดงขนาดและ
รูปร่างของโลกได้อย่างถูกต้อง ดังนั้นเพื่อความสะดวกต่อการพิจารณาลักษณะรูปทรง สัณฐานของโลก ในการท า
แผนที่จึงมีการแบ่งลักษณะรูปทรงสัณฐานของโลกออกเป็น 3 แบบ คือ 

1. ลักษณะรูปทรงกลม (spheroid) เป็นรูปทรงที่ง่ายที่สุด เหมาะส าหรับใช้เป็นสัณฐานของโลก
โดยประมาณ ใช้กับแผนที่มาตราส่วนเล็กท่ีมีขอบเขตกว้าขวาง เช่นแผนที่โลก แผนที่ทวีป หรือแผนที่อ่ืน ๆ ที่ไม่
ต้องการความละเอียดถูกต้องสูง 

2. ลักษณะรูปทรงวงรี (ellipsoid) โดยทั่วไปมีลักษณะรูปทรงที่แตกต่างกับรูปทรงกลมเพียง
เล็กน้อย ซึ่งจะมีลักษณะใกล้เคียงกับสัณฐานจริงของโลกมาก เหมาะส าหรับใช้เป็นพื้นผิวในการรังวัดและการท า
แผนที่ที่ต้องการความละเอียดถูกต้องสูง เช่ น แผนที่ระดับชุมชนเมือง แผนที่ภูมิประเทศมาตราส่วนใหญ่ทั่วไป 
แผนที่น าร่องเป็นต้น 

3. ลักษณะรูปทรงจีออยด์ (geoid) เป็นรูปทรงที่เหมือนกับสัณฐานจริงของโลกมากท่ีสุด เกิดจาก
การสมมติระดับน้ าในมหาสมุทรขณะทรวงตัวอยู่นิ่ง เชื่อมโยงให้ทะลุไปถึงกันทั่วโลก จะเกิดเป็นพ้ืนผิ วซึ่งไม่
ราบเรียบตลอด มีบางส่วนที่ยุบต่ าลง บางส่วนสูงขึ้น ขึ้นอยู่กับความหนาแน่นและแรงโน้มถ่วงของโลก ทุก ๆ 
แนวดิ่ง (plumb line) จะตั้งฉากกับจีออยด์ มีบทบาทส าคัญในงานรังวัดชั้นสูง (geodesy) แต่กลับไม่มีบทบาท
โดยตรงกับวิชาการแผนที่ นอกจากจะใช้ในการค านวณแผนที่ประกอบกับรูปทรงรี 

 

     

 



 

- 9 - 

แนวคิดของระบบพิกัด 
  ในความเป็นจริง รูปทรงของโลกเป็นรูปทรงรี (spheroid/ellipsoid) และมีพ้ืนผิวไม่ราบเรียบ  การ
ถ่ายทอดหรือจ าลองรูปลักษณ์ต่างๆ บนพื้นผิวโลกลงไปบนกระดาษแผ่นราบหรือบนแผนที่  รูปลักษณ์เหล่านี้จะเกิด
การบิดเบี้ยว (distortion) ขึ้น จากข้อเท็จจริงนี้ จึงไม่มีแผนที่ใดสามารถ จ าลองรูปทรงรีของโลกตามลักษณะความ
เป็นจริงได้อย่างสมบูรณ์ ดังนั้น หากต้องการจ าลอง รูปลักษณ์บนผิวโลกให้แม่นย า มากที่สุดจะต้องรักษาคุณสมบัติ
เกี่ยวกับทิศทาง พ้ืนที่ หรือรูปร่าง ไว้บน พ้ืนผิวทรงกลมที่ใกล้เคียงกับพื้นผิวโลกมากที่สุด ด้วยเหตุนี้ จึงมีแนวคิดใน
การสร้างระบบพิกัดและ การฉายภาพแผนที่ขึ้นมาเพ่ือช่วยลดปัญหาในการผลิตแผนที่ที่เกิดข้ึนดังกล่าว 
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  เป็นระบบพิกัดที่ก าหนดต าแ หน่งต่างๆ บนพ้ืนโลก ด้วยวิธีการอ้างอิงบอกต าแหน่งเป็นค่าระยะ
เชิงมุมของละติจูด (Latitude) และลองจิจูด (Longitude) ตามระยะเชิงมุมท่ีห่างจากศูนย์ก าเนิดของละติจูดและ
ลองจิจูดที่ก าหนดขึ้นส าหรับศูนย์ก าเนิดของละติจูด (Origin of latitude) นั้น ก าหนดขึ้นจากแนวระดับท่ี ตัดผ่าน
ศูนย์กลางของโลกและตั้งฉากกับแกนหมุน เรียกแนวระนาบศูนย์ก าเนิดนั้นว่า เส้นระนาบศูนย์สูตรซึ่งแบ่งโลก
ออกเป็นซีกโลกเหนือและซีกโลกใต้ ฉะนั้นค่าระยะเชิงมุมของละติจูด จะเป็นค่าเชิงมุมท่ีเกิดจากมุมที่ศูนย์กลางของ
โลก กับแนวระดับฐานก าเนิดมุมท่ีเส้นระนาบศูนย์สูตร โดยวัดค่าของมุมออกไปทางซีกโลกเหนือและทางซีกโลกใต้ 
ค่าของมุมจะสิ้นสุดที่ข้ัวโลกเหนือและขั้วโลกใต้ มีค่าเชิงมุม 90 องศาพอดี ดังนั้นการใช้ค่าระยะเชิงมุมของละติจูด
อ้างอิงบอกต าแหน่งต่างๆ นอกจากจะก าหนดเรียกค่าวัดเป็น องศา ลิปดา และพิลิปดา แล้ว จะก ากับด้วยตัว อักษร
บอกทิศทางเหนือหรือใต้เสมอ เช่น ละติจูดที่ 30 องศา 20 ลิปดา 15 พิลิปดาเหนือ 
 

 

 
ส่วนศูนย์ก าเนิดของลองจิจูด (Origin of longitude) นั้น ก าหนดขึ้นจากแนวระนาบทางตั้งที่ผ่านแกน

หมุนของโลกตรงบริเวณต าแหน่งบนพื้นโลกท่ีผ่านหอสังเกตการณ์ดาราศาสตร์ เมืองกรีนิช (Greenwich) ประเทศ
อังกฤษ เรียกศูนย์ก าเนิดนี้ว่า เส้นเมริเดียนแรก (Prime meridian) เป็นเส้นที่แบ่งโลกออกเป็นซีกโลกตะวันตก
และซีกโลกตะวันออก    ค่าระยะเชิงมุมของลองจิจูดเป็นค่าที่วัดมุมออกไปทางตะวันตก และตะวันออกของเส้น   
เมริเดียนแรกวัดจากศูนย์กลางของโลกตามแนวระน าบที่มีเส้นเมริเดียนแรกเป็นฐานก าเนิดมุม ค่าของมุมจะสิ้นสุด
ที่เส้นเมริเดียนตรงข้ามกับเส้นเมริเดียนแรกซึ่งมีค่าของมุมซีกโลกละ 180 องศา การใช้ค่าอ้างอิงบอกต าแหน่งใช้
เรียกก าหนดเช่นเดียวกับละติจูด แต่ต่างกันที่ต้องบอกเป็นซีกโลกตะวันตก หรือซีกโลกตะวันออกแทน เช่น  
ลองจิจูดที่ 90 องศา 20 ลิปดา 45 พิลิปดาตะวันตก 
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ประเทศไทยอยู่ในโซน GZD 47N 47P 47Q 48N 48P และ   Q

 



- 21 - 

 

 

 
 



- 22 - 
     

การวิเคราะห์แผนที่เวคเตอร์  
   (Vector Analysis Tools) 

             

 การวิเคราะ ห์หรือการจัดการแผนที่เวคเตอร์ สามารถกระท าได้หลายวิธี ขึ้นอยู่กับเราจะปรับใช้ให้
เหมาะสมกับงาน เช่น การใช้ค าสั่ง Clip (ตัด) , Dissolve (การสลาย) , Erase (ลบ) , Intersect (หาพื้นที่ทับซ้อน) 
, Union (การรวมพ้ืนที่ ) , Merge (การรวมชั้นข้อมูล ) , Append (การเพ่ิมข้ันข้อมูล) , Selection (การเลือก)  
เป็นต้น 
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 เป็นฟังชั่นส าหรับตัดข้อมูลที่ต้องการตามขอบที่ก าหนด โดยตัดข้อมูลแผนที่ออกจากชั้นข้อมูลที่
ต้องการ (Input Feature) ด้วยแผนที่หรือพ้ืนที่ที่เป็นขอบตัด (Clip Feature) เช่นต้องการขอบเขตพ้ืนที่แสดง
ปริมาณน้ าฝนเฉพาะจังหวัดที่ต้องการเท่านั้น (Output feature) ทั้งนี้จะใช้ขอบเขตจังหวัดเป็นขอบในการตัดพ้ืนที่
แสดงปริมาณน้ าฝน ตามรูปภาพ  

 

 

 
ค าอธิบายรูปภาพ : เราต้องการตัดแผนที่จังหวัดกาฬสินธ์ จากแผนที่ภาคตะวันออกเฉียงเหนือ (รายอ าเภอ) เราใช้
แผนที่จังหวัดกาฬสินธ์เป็นขอบในการตัดและจะได้ผลลัพธ์ เป็นแผนที่จังหวัดกาฬสินธ์ที่เป็นรายอ าเภอ  

 

Input Feature 

Output Feature 

Clip Feature 
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ค าอธิบายรูปภาพ : เราต้องการตัดแผนที่ (จุด) สถานีตรวจวัดฝน ทั่วประเทศโดยใช้ขอบภาคตะวันออกเฉียงเหนือ
ตัด จะได้ผลลัพธ์เป็น สถานีตรวจวัดฝนบริเวณภาคตะวันออกเฉียงเหนือ 

 

ค าอธิบายรูปภาพ : เราต้องการตัดแผนที่แม่น้ าทั่วประเทศไทย โดยใช้ขอบภาคตะวันออกเฉียงเหนือตัด จะได้
ผลลัพธ์เป็น แผนที่แม่น้ าบริเวณภาคตะวันออกเฉียงเหนือ 

 

Input Feature 

Output Feature 
Clip Feature 

Clip Feature Output Feature 

Input Feature 
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 ค าสั่ง Dissilve คือ ค าสั่งใช้ส าหรับการรวมกลุ่มข้อมูลพื้นที่ท่ีมีคุณสมบัติหรือ ค่า Attribute 
เหมือนกั นที่อยู่ติดกันเข้าด้วยกัน เพื่อลดความซ้ าซ้อนของชั้นข้อมูล ซึ่งเป็นการเอาเส้นขอบเขตของพ้ืนที่ที่มีค่า
เหมือนกันในหนึ่งหรือหลายฟิวส์ออกไป เช่น แผนที่ขอบเขตต าบลและอ าเภอ แต่ต้องการใช้ข้อมูลเพียงขอบเขต
อ าเภอ  เราก็จะท าการ Dissilve เพ่ือลบฟิวส์ขอบเขตต าบลออก และรว มฟิวส์ขอบเขตอ าเภอเข้าด้วยกัน ดัง
รูปภาพ 

 
 

 
 

ค าอธิบายรูปภาพ : การใช้ค าสั่ง Dissolve เพ่ือท าแผนที่ภาคตะวันออกเฉียงเหนือที่มีข้อมูลขอบเขตต าบล อ าเภอ 
และจังหวัดรวมกันอยู่  ให้เป็นแผนที่ภาคตะวันออกเฉียงเหนือเฉพาะขอบเขตรายอ าเภอ และรายจังหวัด  
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 ค าสั่ง Merge เป็นการรวมฟีเจอร์จากหลายชั้นข้อมูลเข้าเป็นชั้นข้อมูลเดียวกัน ค าสั่ง Merge 
สามารถด าเนินการได้ทั้งข้อมูลที่เป็น Point , Line หรือ Polygon เพ่ือเป็นการเชื่อมต่อแผนที่ที่มีระบบพิกัด
ภูมิศาสตร์อยู่ในพื้นท่ีใกล้เคียงกันหรือต่อกัน ผลลัพธ์ที่ได้จะสร้างชั้นข้อมูลใหม่ที่มีข้อมูลต่อกัน ดังนั้นจึงไม่
เปลี่ยนแปลงไฟล์ต้นฉบับเดิม 

 

 

 

ค าอธิบายรูปภาพ : จากรูปภาพเราต้องการรวมแผนที่ 3 ชั้นข้อมูล คือ แผนที่จังหวัดหนองคาย (1 )แผนที่จังหวัด 
บึงกาฬ (2) และแผนที่ภาคตะวันออกเฉียงเหนือตอนบนไม่มีจังหวัดหนองคายและบึงกาฬ  (3) เป็นแผนที่เดียวคือ
แผนที่ภาคตะวันออกเฉียงเหนือตอนบน 11 จังหวัด (รวมหนองคายและบึงกาฬ) โดยใช้ค าสั่ง Merge ผลลัพธ์จะได้
คือแผนที่ภาคตะวันออกเฉียงเหนือตอนบนซึ่งมีจังหวัดหนองคายและบึงกาฬ 
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 การ Selection เป็นเครื่องมือหนึ่งที่ใช้ในการสอบถามข้อมูล เพ่ือให้ได้ ข้อมูลพื้นที่ท่ีเราต้องการ 
สามารถกระท าได้ 3 วิธี คือ 

1. การ Select จากพ้ืนที่ (Features) 
2. การ Select จากตารางข้อมูล (Attribute) 
3. การ Select สอบถามโดยใช้ค าสั่ง (Query Builder) 

 

 การ Selection จากพ้ืนที่ (Features) เป็นการใช้ค าสั่ง Selection กระท าบนพ้ืนที่ (Features) ที่
ต้องการ โดยใช้เมาส์คลิ๊กบนพ้ืนที่ เช่นตามตัวอย่างดังรูปภาพเราต้องการสอบถามข้อมูลอ าเภอในจังหวัดขอนแก่น 
เราสามารถน าเมาส์คลิ๊กที่ขอบเขตพ้ืนที่อ าเภอที่เราต้องการได้เลย 
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 การ Selection จากตารางข้อมูล (Attribute) เป็นการใช้ค าสั่ง Selection กระท าท่ีตารางข้อมูล 
(Attribute) โดยใช้เมาส์เลือกไปที่แถวของข้อมูลที่ต้องการ เช่น ต้องการเลือกพ้ืนที่จังหวัดนครพนม กาฬสินธ์และ
เลย เราก็ใช้เมาส์คลิ๊กเลือกที่แถวที่ตารางข้อมูลจังหวัดนั้น ๆ ตามรูปภาพ ผลลัพธ์ที่ได้ก็จะเห็นแผนที่ แสดงพื้นท่ี
ขอบเขตจังหวัดที่ถูกเลือกไว้ (สีฟ้า) 
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 เป็นการใช้ค าสั่งสอบถามไปยังฟิวส์ข้อมูล โดยเลือกฟิวส์ข้อมูลที่ต้องการแล้วก าหนดความต้องการ
ผ่านค าสั่งตัวด าเนินการเปรียบเทียบ เช่น = , > , < , ><  ตัวเชื่อมนิพจน์ เช่น And Or Not Is เพ่ือให้ได้ผลลัพธ์
ตามท่ีเราต้องการ เช่น ต้องการสอบถามข้อมูลแผนที่ จังหวัด ขอนแก่น ชัยภูมิ นครพนม จากแผนที่ภาคตะวัน 
ออกเฉียงเหนือ เราก็ใช้ค าสั่งเลือกฟิวส์ “Prov_NAMT” = “ขอนแก่น” Or “Prov_NAMT” = “ชัยภูมิ Or 
“Prov_NAMT” = นครพนม แล้วกด Apply , ok  ผลลัพธ์ที่ได้คือ แผนที่ภาคตะวันออกเฉียงเหนือที่สอบถาม
ข้อมูลจังหวัดทั้ง 3 จังหวัดดังกล่าว  
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ฝึกปฏิบัติ (WORKSHOP) 
การจัดท าแผนที่ภาคตะวันออกเฉียงเหนือตอนบน (เพิ่มจังหวัดบึงกาฬ) 

โดยใช้โปรแกรม Arcgis 10.1 

1. เปิดโปรแกรม Arcgis 10.1  
         1.1 ท าการ Add Data แผนที่ Ne_lat ซึ่งเป็นแผนที่ภาคตะวันออกเฉียงเหนือมีฟิวส์ขอบเขตการ
ปกครองระดับต าบล อ าเภอ และจังหวัด 

 
 
  1.2 เปิดตาราง (Attribute) โดยคลิ๊กขวาที่ Ne_lat แล้วเลือก Open Attribute Table ของข้อมูล
แผนที่ภาคตะวันออกเฉียงเหนือ 
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  1.3 ผลลัพท์ท่ีได้จะเห็นว่ามีฟิวส์ขอบเขตการปกครอง 3 ฟิวส์ ระดับต าบล อ าเภอ และจังหวัด 

 

2. ท าการ Dissolve เพ่ือจัดเตรียมแผนที่ขอบเขตอ าเภอ และจังหวัด 
 2.1 ท าการ Dissolve แผนที่ขอบเขตระดับอ าเภอ ไปที่แถบเมนู Geoprocessing เลือก Dissolve  
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             2.2 Input Features เลือก Ne_lat , Output Feature class ตั้งชื่อไฟล์แล้วก าหนดที่อยู่ของ
ไฟล์ไว้ในที่นี้จะตั้งชื่อไฟล์ว่า Ne_amp ก าหนดที่อยู่ของไฟล์ Dissole_Field (s) (option) ติ๊กถูกเพ่ือเลือกฟิลด์ 
AMP_NAMT แล้วคลิ๊ก ok 

 

2.3 ผลลัพท์ท่ีได้ คือ แผนที่ภาคตะวันออกเฉียงเหนือขอบเขตระดับอ าเภอ ตามรูปภาพ 
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 2.4 ท าการ Dissole แผนที่ให้เป็นแผนที่รายจังหวัด ขั้นตอนท าเหมือน 2.1  
แต่ในข้ันตอนที่ 2.2 ที่ Dissole_Field (s) (option) ให้ติ๊กถูกเพ่ือเลือกฟิลด์ PROV_NAMT แล้วคลิ๊ก ok ตาม
รูปภาพ 

 

2.4 ผลลัพธ์ที่ได้คือ แผนที่คือ แผนที่ภาคตะวันออกเฉียงเหนือขอบเขตระดับจังหวัด ตามรูปภาพ 
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3. การจัดท าแผนที่ภาคตะวันออกเฉียงเหนือตอนบน รายจังหวัด 
  3.1 ท าการ Seclect เพ่ือเลือกแผนที่ขอบเขตพ้ืนที่จังหวัด 9 จังหวัด ได้แก่ เลย อุดรธานี 
หนองบัวล าภู สกลนคร นครพนม กาฬสินธ์ มหาสารคาม ขอนแก่น และชัยภูมิ ยกเว้น หนองคาย โดยการใช้วิธี
Selection บนพื้นที่ (Features) ไปที่ Select Features เลือก Select by Rectangle จากนั้นกด Shift ค้างไว้
แล้วใช้เมาส์เลือกขอบเขตพ้ืนที่จังหวัดทั้ง 9 จังหวัดตามรูปภาพ  

 

 3.2  ท าการ Save แผนที่ให้เป็น Shape File (ไฟล์ถาวร) โดยไปท่ีชื่อแผนที่ (Ne_prov) ที่ Table 
Of Contents เลือก Data>Export Data ตั้งชื่อไฟล์ (Neupper_nonongkai) ก าหนดที่จัดเก็บแล้วคลิ๊ก ok 
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3.3  ผลลัพธ์ที่ได้คือ แผนที่ขอบเขตพ้ืนที่จังหวัด 9 จังหวัด ตามรูปภาพ 

 

3.4  ท าการแยกแผนที่จังหวัดหนองคาย ออกเป็น 2 จังหวัด คือ หนองคาย และบึงกาฬ ขั้นตอนคือ 
เปิดแผนที่ภาคตะวันออกเฉียงเหนือรายจังหวัดที่ได้จัดเตรียมไว้แล้วและท าการ Select Features เลือกแผนที่
ขอบเขตจังหวัดหนองคาย 

 

 -  
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 3.5 ท าการ Save แผนที่ให้เป็น Shape File (ไฟล์ถาวร) โดยไปท่ีชื่อแผนที่ (Ne_prov) ที่ Table 
Of Contents เลือก Data > Export Data ตั้งชื่อไฟล์ (Nongkai_prov_old) ก าหนดที่จัดเก็บแล้วคลิ๊ก ok  
ผลลัพธ์ที่ได้ตามรูปภาพ 

 

 3.6 ท าการ clip เพ่ือตัดแผนที่จังหวัดหนองคายให้เป็นรายอ าเภอ โดยใช้ค าสั่ง clip ไปที่ 
Geoprocessing > clip   
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 3.7 Input Features เลือกแผ นที่จังหวัดหนองคายขอบเขตจังหวัด (Nongkai_prov_old)  
Clip Features เลือกแผนที่ภาคตะวันออกเฉียงเหนือขอบเขตอ าเภอ (Ne_amp) Output Feature Class  
ก าหนดที่อยู่ของไฟล์และตั้งชื่อไฟล์ (Nongkai_amp_old) คลิ๊ก ok 

 

 3.8 ผลลัพธ์ที่ได้คือแผนที่จังหวัดหนองคาย (เดิม) ขอบเขตอ าเภอ (Nongkai_amp_old) 
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3.9 ท าการ select อ าเภอของจังหวัดหนองคาย (เดิม) ออกมา 8 อ าเภอ ได้แก่ เซกา โซ่พิสัย  
พรเจริญ บุ่งคล้า บึงโขงหลง ศรีวิไล ปากคาด และบึงกาฬ  
 

           

 3.10 ท าการ Save แผนที่ให้เป็น Shape File (ไฟล์ถาวร) โดยไปท่ีชื่อแผนที่ (Nongkai_amp_old) 
ที่ Table Of Contents เลือก Data > Export Data ตั้งชื่อไฟล์ (buengkan_amp) ก าหนดที่จัดเก็บแล้วคลิ๊ก ok  
ผลลัพธ์ที่ได้ตามรูปภาพ 
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 3.11 ท าแผนที่จังหวัดบึงกาฬขอบเขตอ าเภอ ให้เป็นขอบเขตจังหวัด โดยวิธีการใช้ค าสั่ง clip ไปที่ 
Geoprocessing เลือก Clip , Input Features เลือก Nongkai_prov_old > Clip Features เลือก 
buengkan_amp > Output Feature Class ก าหนดที่อยู่และตั้งชื่อไฟล์เป็น buengkan_prov คลิ๊ก ok 

 

 3.12 ผลลัพท์ท่ีได้คือแผนที่จังหวัดบึงกาฬขอบเขตจังหวัด (ตามรูปภาพ) 
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 3.13 จัดท าแผนที่จังหวัดหนองคาย (ใหม่) วิธีการท าเหมือนขั้นตอนที่ 3.9  แต่เปลี่ยนการ Select 
Feature อ าเภอ เป็น ท่าบ่อ เฝ้าไร่ โพธิ์ตาก โพนพิสัย เมืองหนองคาย รัตนวาปี ศรีเชียงใหม่ สระใคร และสังคม 
จากนั้นท าเหมือนขั้นตอนที่ 3.10 – 3.11 จะได้ผลลัพธ์ คือ แผนที่จังหวัดหนองคายขอบเขตจังหวัด (ตามรูปภาพ)  

 

3.14 ท าการรวมแผนที่ 3 ส่วน คือ แผนที่จังหวัด 9 จังหวัด + แผนที่จังหวัดบึงกาฬ + แผนที่
จังหวัดหนองคาย เข้าด้วยกันตามรูปภาพ 

 

 

1 

2 

3 
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3.15 ใช้ค าสั่ง Merge รวมแผนที่ 3 ส่วนเข้าด้วยกันให้เป็น Shape file เดียวกัน โดยไปท่ี  
Geoprocessing เลือก Merge > Input Datasets ให้เลือกแผนที่ทั้ง 3 ส่วน Output Dataset หาที่อยู่และตั้งชื่อ
ไฟล์ว่า Neupper_new.shp คลิ๊ก ok  

 

3.16 ผลลัพธ์ที่ได้คือแผนที่ภาคตะวันออกเฉียงเหนือตอนบน 11 จังหวัด ตามรูปภาพ เพ่ือน าไปใช้
งานในขั้นตอนต่อไป 
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2. การประยุกต์ใช้โปรแกรม Arcgis 10.1 

เพื่อการประมาณค่าช่วง ( Interpolation ) 
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การประมาณค่าช่วง (Interpolation) เป็นการท านายค่าตัวเลขบริเวณท่ีไม่มีข้อมูลเพื่อให้มีความต่อเนื่อง 
ของข้อมูลในทุกพ้ืนที่  โดยการประมาณค่าข้อมูลเชิงพ้ืนที่ด้วยเทคนิคทางระบบสารสนเทศภูมิศาสตร์จะให้ผลลัพธ์
ออกมาเป็นข้อมูลแบบราสเตอร์ (Raster Format)  
 

 

รูปภาพที่ 1. แสดงการประมาณค่าช่วงจากจุดที่ทราบค่า (ซ้ายมือ) ท านายข้อมูลพื้นที่ท่ีไม่ทราบค่า (ขวามือ) 
 

 

รูปภาพที่ 2 แสดงการประมาณค่าช่วงจากจุด (สีแดง) ที่ทราบค่า ท านายค่าพ้ืนที่ที่ไม่ทราบค่าโดยใช้เทคนิคทาง
ระบบสารสนเทศภูมิศาสตร์ (GIS) ได้ผลลัพธ์เป็นข้อมูลแบบราสเตอร์ (Raster Format) 
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ข้อมูลที่นิยมใช้ในการประมาณค่า ( Interpolation ) ได้แก่ 
•   ข้อมูลอุตุนิยมวิทยา (Meteorological Data) เช่นน้ าฝน อุณหภูมิและการระเหย 

•   ภูมิประเทศ (Topography) เช่น ความสูงต่ าของพ้ืนที่  

•   การสะสมของหิมะ (Snow Accumulation)  

•   ระดับน้ า (Water Table) 

•   ความหนาแน่นประชากร (Population Densit)  

      วิธีที่ใช้ในการประมาณค่าช่วง 
 
       เทคนิควิธีที่ใช้ในการประมาณค่าช่วงมีแต่ในที่นี้จะขอกล่าวถึงเพียง 2 วิธีซึ่งเป็นวิธีที่เหมาะสมกับ
การประมาณค่าข้อมูลอุตุนิยมวิทยา คือ 

1. การประมาณค่าช่วง วิธี IDW  ( Inverse Distance Weight ) 
2. การประมาณค่าช่วง วิธี Kriging 

 
1. การประมาณค่าช่วง วิธี IDW  ( Inverse Distance Weight )  

  เป็นการประมาณค่าโดยท าการสุ่มจุดตัวอย่างแต่ละจุดจากต าแหน่งที่สามารถส่งผลกระทบไปยัง
เซลล์ที่ต้องประมาณค่าได้ ซึ่งจะมีผลกระทบ น้อยลงเรื่อย ๆ ตามระยะทางท่ีไกลออกไปเหมาะกับตัวแปรที่อ้างอิง

กับระยะทางในการค านวณ ยิ่งใกล้ยิ่งมีอิทธิพล มาก เช่น ความดังของเสียง ความเข้มข้นของสารเคมี  
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2. การประมาณค่าช่วง วิธี Kriging 
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ขั้นตอนการประมาณค่าช่วง (Interpolation) ข้อมูลปริมาณน้ าฝนด้วยโปรแกรม Arcgis 10.1 

1. การจัดเตรียมตารางข้อมูลด้วยโปรแกรม Ms excel โดยสร้างฟิลด์ก าหนดค่า X=st_long y=st_lat  
และ z=ra 
1.1 ก าหนดค่าของ Lat , long ให้ใช้ค่าที่มีหน่วยเป็น Decimal degree (DD)  

 

 

 

 

1.2 ตั้งค่าจัดรูปแบบเซลล์ Z (ปริมาณน้ าฝน) เป็นตัวเลขทศนิยม 1 ต าแหน่ง 

 

 

 

 

Y=st_lat x=st_long Z=ra 

 

Decimal degree (DD) 
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2. ท าการ add data เพ่ือน าเข้าแผนที่ขอบเขตพ้ืนที่การปกครอง (Shape file) ในที่นี้จะใช้แผนที่พื้นที่ความ
รับผิดชอบภาคตะวันออกเฉียงเหนือตอนบน 11 จังหวัด ที่ได้จัดเตรียมไว้แล้ว 

2.1 add data เลือกแผนที่ขอบเขตพ้ืนที่การปกครอง ne_upper_new 
 

 

a. ท าแผนที่ให้โปร่งใส ดับเบิ้ลคลิ๊กท่ีกรอบสี่เหลี่ยม เลือก hollow คลิ๊ก ok 
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b. ท าการใส่ label ป้ายชื่อจังหวัด ดับเบิ้ลคลิ๊กที่แผนที่ ne_upper_new เลือก label   ติ๊กถูกท่ี 
Label features in this layer  ที่ Label field เลือก PROV_NAMT  เลือกชนิดขนาดและสีของ font    
คลิ๊ก Apply คลิ๊ก ok 

 

ผลลัพธ์ที่ได้ตามรูปภาพ 
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2.2 ขั้นตอนการท าการสร้าง shape file จากไฟล์ excel  

2.2.1 เปิด catalog แล้วเปิดไฟล์ที่ได้จัดเตรียมไว้ (ฝั่งขวามือ) ne_upper  
     ใช้เมาส์ลากไปยัง Table Of Content (ฝั่งซ้ายมือ) 
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  2.2.2 สร้าง x , y data โดยคลิ๊กขวาที่ Ne_upper เลือก Display XY Data……….. 

 

 2.2.3 X Field เลือก St_Long , Y Field เลือก St_Lat คลิ๊ก ok 
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  2.2.4 ผลลัพธ์ที่ได้คือ จุด (Point) ของสถานีตรวจวัดข้อมูลฝนอ าเภอต่างๆ ในพื้นที่ภาค
ตะวันออกเฉียงเหนือตอนบน (จุดสีแดงตามรูปภาพ) 

 

 
2.3  ขั้นตอนการประมาณค่าช่วงข้อมูลปริมาณน้ าฝน (Interpolation) ด้วยวิธีการ IDW   

2.3.1 ไปที่ search (Ctrl+F) พิมพ์ IDW คลิ๊ก  เลือก IDW (Spacial Analyst) (Tool)
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  2.3.2 Input point features เลือก Ne_upper$Events , Z value Field เลือก Ra 
Output raster ก าหนดที่จัดเก็บข้อมูลและตั้งชื่อไฟล์ Output cell size (optional) ใช้ค่าตามสมการ(ไม่แก้ไข)  
power (optional) = 2 , Number of points = 12  จากนั้นคลิ๊ก environments  

 

  2.3.3 คลิ๊กท่ี Processing Extent เลือก Same as layer neupper_new 
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  2.3.4 คลิ๊ก Raster Analysis >Mask เลือก Neupper_new คลิ๊ก ok , ok 

 
 

  2.3.5 จะได้ผลลัพธ์ตามรูปภาพ 
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2.4 การแบ่งชั้นข้อมูล (Reclassified)  เพ่ือแบ่งระดับ จ านวน และระยะห่างของชั้นข้อมูล
ตามท่ีเราต้องการ ในที่นี่จะแบ่งชั้นข้อมูลปริมาณน้ าฝนสะสมรายวันเป็น 14 class เริ่มจาก 0 มม. จนถึง 500 มม. 
ขั้นตอนมีดังนี้ 
   2.4.1 ดับเบ้ิลคล๊ิกท่ีแผนท่ี Raster ที่ประมาณค่าช่วงด้วยวิธี idw ในที่นี้ชื่อไฟล์ว่า 1 
จากนั้นเลือก Symbology > classified และคลิ๊กที่ classify….  

 

  2.4.2 แบ่ง class เป็น 14 ชั้น และพิมพ์แก้ไขจ านวนตัวเลขของชั้นข้อมูลที่ Break values 
คลิ๊ก ok > apply > ok 
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  2.4.3 จะได้ผลลัพธ์ตามรูปภาพ 

 
   
  2.4.4 ท าการจัดเก็บ layer ชั้นข้อมูลไว้ใช้งาน ไปที่แผนที่ Raster ชื่อไฟล์ 1 คลิ๊กขวาแล้ว
เลือก Save as layer file… 
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  2.4.5 ตั้งชื่อไฟล์ (*.lyr) แล้ว save จัดเก็บ Layer ของชั้นข้อมูลที่เราได้แบ่งชั้นข้อมูล 
(Recalssified) ไว้ใช้งานในครั้งต่อไป 
 

 

2.5 การสร้าง Layout  เพื่อการน าเสนอ 
   หลังจากเราได้แผนที่การประมาณค่าช่วงข้อมูลปริมาณน้ าฝนแล้ว เราจะต้องจัดท า Layout 
แผนที่เพื่อใช้ในการน าเสนอข้อมูลต่อไป ตามขั้นตอนดังนี้ 
                        2.5.1 เปลี่ยนมุมมองจาก Data view เป็น Layout view  
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2.5.2 ท าการน าเข้า (Insert Legend) ไปที่แถบ Menu bar Insert เลือก Legend  
คลี๊ก next > next > next > next > finish จากได้ผลลัพท์ตามรูปภาพ 
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  2.5.3 ท าการแตก Legend ออกเป็นชิ้นส่วนก่อนจัดรูปแบบให้เหมาะสมและสวยงาม โดย
คลิ๊กขวาที่พ้ืนที่ของ Legend เลือก Convert To Graphic > เลือก ungroup เพ่ือแตก Legend เป็นชิ้นส่วน 

 

  2.5.4 เมื่อท าการจัดรูปแบบ Legend เสร็จเรียบร้อยแล้วให้ท าการ Group  
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  2.5.5 จะได้ Legend ที่จัดรูปแบบเรียบร้อยแล้วตามรูปภาพ 
 

 

  2.5.6 ท าการใส่ลูกศรก ากับทิศ โดยไปท่ีแถบ Menu bar Insert เลือก North Arrow ตาม
รูปภาพ 
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  2.5.7 เลือกรูปแบบของลูกศรก ากับทิศตามท่ีต้องการ แล้วคลิ๊ก ok 

 

 2.5.8 ใส่ภาพโลโก้กรมอุตุนิยมวิทยา , ข้อความหัวข้อเรื่อง , ค าอธิบาย ข้อความอ่ืน ๆ โดยไปท่ี 
Menu bar Insert เลือก picture >Insert Picture ภาพโลโก้กรมอุตุนิยมวิทยาตามต าแหน่งที่อยู่ของไฟล์รูปภาพ 
ไปที่ Menu bar Insert เลือก Title หรือ Text เพ่ือพิมพ์ข้อความ 
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2.6 ขั้นตอนการ Save Project เพ่ือจัดเก็บงานทั้งหมด ไปที่ File > Save As ตั้งชื่อโปรเจค 
ก าหนดที่จัดเก็บ แล้วกด Save  
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3. การใช้งานโปรแกรม Surfer 10 
 

 
 
 
 

เพื่อการน าเสนอข้อมูลอุตุนิยมวิทยา 
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 3.1 เปิดโปรแกรม Surfer 10 
 

 
 3.2 ท าการ ขั้นตอนการ Digitize เพ่ือลอกลายเส้นขอบเขตพ้ืนที่ภาคตะวันออกเฉียงเหนือตอนบน 
โดยไปท่ี Map เลือก New เลือก Base Map….. 

 

 

 

Double Click 
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 3.3 เปิดแผนที่ Neupper.shp เพ่ือท าการลอกลายเส้น (Digitize)  

 

 

 
 3.4 ไปที่ Map คลิ๊กขวาเลือก Digitize  
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 3.5 ท าการ digitize ลอกลายเส้นแผนที่ขอบเขต โดย Zoom ให้เส้นละเอียดขึ้นเพ่ือให้ผลการ 
digitize ที่ละเอียดที่สุด  

 

 3.6 เมื่อ digitize เสร็จแล้ว save as เป็น file *.bln (Boundary Files) ne_upper.bln เพ่ือ
น าไปใช้งานต่อไป  
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 3.7 ก าหนดค่า x , y (lat,long) ของแผนที่ ซึ่งจะประกอบด้วย ค่า min , max ของค่า x และค่า 
min , max ของค่า y 

  

3.8 บันทึกค่า x (long) , y (lat) ของแผนที่ ne_upper เก็บไว้เพ่ือน าไปใช้งานต่อไป 
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การจัดท าแผนที่อุณหภูมิสูงสุด ต่ าสุด และอุณหภูมิเปลี่ยนแปลง 

3.9 การจัดเตรียมข้อมูล (Grid point)  
3.9.1  จัดเตรียมข้อมูลอุณหภูมิสูงสุด อุณหภูมิต่ าสุด โดยเรียกจากข่าว Decode และจากรายงาน 

ข้อมูลฯ จังหวัดเลยทาง e-mail  
3.9.2 เปิดไฟล์ข้อมูล excel อยู่ที่ d:\data_center\GIS\surfer\data\txtn_neupper.xls  

ดังรูปแบบตามภาพที่ 1 แล้วท าการบันทึกแก้ไขข้อมูลปัจจุบันทั้ง 4 ช่องคือ อุณหภูมิสูงสุด (tx) อุณหภูมิสูงสุด
เปลี่ยนแปลง (Dtx) อุณหภูมิต่ าสุด (tn) อุณหภูมิสูงสุดเปลี่ยนแปลง (Dtx) 

 
 

 
 

* อุณหภูมิสูงสุดต่ าสุดเปลี่ยนแปลง เพิ่มขึ้นเป็น + ลดลงเป็น – โดยน าข้อมูลวันนี้
เปรียบเทียบกับเม่ือวาน (ในข่าว decode มีข้อมูลแล้ว) หาเฉพาะข้อมูลของจังหวัดเลย 
 

3.9.3 save as เพ่ือบันทึกจัดเก็บไฟล์ข้อมู ลที่แก้ไขแล้ว จัดเก็บไฟล์ไว้ที่
d:\data_center\GIS\surfer\data\Dec\ตั้งชื่อไฟล์ในรูปแบบ txtnddmmyyyy เช่น txtn01122559 .xls  
เป็นต้น 
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3.10 เปิดโปรเจคจากโปรแกรม Surfer มี 4 โปรเจค คือ temp_max , temp_min 
d_temp_max , d_temp_min ข้อมูลโปรเจคอยู่ที่ d:\data_center\gis\surfer\...... 
โดยคลิ๊กขวาทีช่ื่อโปรเจค เช่น temp_max แล้ว open with เลือก Golden Software Surfer ดับเบ้ิลคล๊ิกเพ่ือ
เปิดโปรแกรม   โดยท าครั้งละโปรเจค 
 

 

 
 
 
 

3.11 ก่อนท าการพล๊อตข้อมูล ต้องท าการหาค่า x (Longitude) , y (Latitude) ก่อนเพื่อน าไปใช้ใน 
การพล๊อตข้อมูล หาแล้วได้ดังนี้  
 
 

ค่า x min = 100.8389  max = 104.8091 
ค่า y min = 15.31362  max = 18.44499 
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3.12 ท าการลบข้อมูล contour (เก่า) ออก เพ่ือไม่ให้เกิดการสับสน โดยท าการ คลี๊กขวาที่ map 
ของ contour แล้วเลือก delete ท าการลบข้อมูลออก 

ผล 

3.12.1 ผลลัพทท์ี่ได้ตามรูปภาพ 
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3.12 ขั้นตอนการวิเคราะห์ข้อมูล ไปที่ Grid เลือก data  
 

 

3.13   เปิดไฟล์ข้อมูล ที่ d:\data_center\GIS\surfer\data\Dec\txtn********.xls  
ค่า x เลือก Long ค่า y เลือก Lat ค่า Z เลือกตามข้อมูลที่ต้องการพล๊อต เช่น หากต้องการพล๊อต อุณหภูมิสูงสุด 
เลือก tx  อุณหภูมิต่ าสุด เลือก tn อุณหภูมิสูงสุดเปลี่ยนแปลง เลือก Dtx อุณหภูมิต่ าสุดเปลี่ยนแปลง เลือก Dtn 
เป็นต้น 
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3.14 ที่ Output Grid File ให้ท าการเก็บไฟล์ไว้ที่d:\data_center\GIS\surfer\Grid\  ตั้งชื่อไฟล์
ชื่อเดิม คือ txtn******** เช่น txtn01122559 เมือ่จัดเก็บแล้ว ไฟล์จะนามสกุล .grd จากนั้น save 

 

3.15 ที่ Grid Line Geometry ใส่ค่า x , y ตามข้อ 3.11 
ค่า x min = 100.8389  max = 104.8091 offline = 1000 
ค่า y min = 15.31362  max = 18.44499 offline = 1000 เสร็จแล้วคลิ๊ก ok และ ok 

ดังรูปภาพ 
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 3.16  

 

 

  3.17  ให้ตอบ No 
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  3.18 ไปที่ Grid เลือก Bank 

 

 

3.19 เลือกไฟล์ที่เก็บไว้ที่ folder Grid (d:\data_center\GIS\surfer\grid\txtn01122559.grd) 
และคลิ๊ก open 
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  3.20 brown เพ่ือหา boundary flie (.BLN) ชื่อ neupper.bln ซึ่งได้ท าการ Digitize จัดเตรียม
ไว้แล้วอยู่ที่ D:\data_center\GIS\surfer\neupper.bln เมื่อหาเจอแล้วคลิ๊กเลือก และกด Open 

 

 3.21 จะได้ไฟล์ที่เป็น output(out)  จัดเก็บไว้ที่ D:\data_center\GIS\surfer\out\ 
ตั้งชื่อเป็น out_txtn01122559.grd จากนั้นท าการ save 
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3.22 คลิ๊ก ok 

 

 

3.23 ไปที่ Map เลือก new เลือก Contour Map… 

 

 

 



- 76 - 

  3.24 เปิดไฟล์ output ที่เก็บไว้ที่ d:\data_center\GIS\surfer\out\out_txtn01122559.grd  
แล้ว open 

 

 

  3.25 ผลลัพธ์ที่ได้ตามรูปภาพ 
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  3.26 คลิ๊กท่ี contour ตามรปูภาพ 

 

 

  3.27  ติ๊กเครื่องหมายถูกที่ Fill contours และ Conlor scale ตามรูปภาพ 
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  3.28  ไปที่ Levels – level method เลือก  advanced 

 

 

  3.29  คลิ๊ก Edit levels 
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3.30  คลิ๊ก Load 

 

 3.31 เปิดไฟล์ level  อยู่ที่ d:\data_center\GIS\surfer\level\ เลือกใช้ level  
ตามข้อมูลที่ต้องการพล๊อต เช่น ต้องการพล๊อตอุณหภูมิต่ าสุดใช้ level_temp_min.lvl อุณหภูมิสูงสุดใช้ 
level_temp_max.lvl อุณหภูมิสูงสุดเปลี่ยนแปลง และอุณหภูมิต่ าสุดเปลี่ยนแปลงใช้ temp_change.lvl เมื่อ
เลือกแล้ว กด open และกด ok 
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  3.32 ผลที่ได้ตามรูปภาพ 

 

  3.33 หากแผนที่แสดงภูมิประเทศ (shape file) อยู่ layer ด้านล่างจะท าให้มองไม่เห็นขอบเขต
จังหวัด ให้ท าการย้ายแผนที่แสดงภูมิประเทศขึ้นไว้ข้างบนโดยใช้เมาส์ลากให้ layer ล่าง ขึ้นอยู่ด้านบน จะได้ตาม
รูปภาพ 
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3.34  ท าการแก้ไขวันที่ให้เป็นปัจจุบัน 

a. อุณหภูมิต่ าสุดให้ใช้วันที่วันนี้และเวลา 07.00 น. เช่น “อุณหภูมิต่ าสุดวันที่  
1 ธันวาคม 2559 (07.00น.) 

b. อุณหภูมิสูงสุดให้ใช้วันที่เมื่อวานและเวลา 19.00 น. เช่น “อุณหภูมิสูงสุดวันที่  
30 พฤศจิกายน 2559 (19.00น.) 

c. อุณหภูมิต่ าสุดเปลี่ยนแปลงให้ใช้วันที่วันนี้และเมื่อวานและเวลา 07.00 น. เช่น
“อุณหภูมิต่ าสุดเปลี่ยนแปลงวันที่ 30 พฤศจิกายน 255 และ 1 ธันวาคม 2559 (07.00น.) 

d. อุณหภูมิสูงสุดเปลี่ยนแปลงให้ใช้วันที่เมื่อวานและวันที่วันก่อนและเวลา 19.00 น. เช่น 
“อุณหภูมิต่ าสุดเปลี่ยนแปลงวันที่ 29 พฤศจิกายน 255 และ 30พฤศจิกายน 2559 (07.00น.) 

 3.35 ขั้นตอนการ export แผนที่ให้เป็นรูปภาพเพ่ือการน าเสนอ และจัดเก็บไฟล์ไว้ใช้งาน 
โดยไปท่ี File เลือก Export 
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   3.36 เลือกชนิดไฟล์ที่ต้องการจัดเก็บ ให้เลือกจัดเก็บเป็น  JPEG  

 

  3.37 จัดเก็บไฟล์ (*.jpeg) ไว้ที่ d:\web_khonkaen\gis\temp_maxหรือ temp_min หรือ 
temp_max \....... 
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3.38 ท าการ Save Project โดยไปที่ File เลือก save as 

 

 

3.39 save โปรเจคให้ใช้ชื่อโปรเจคดังนี้ คือ temp_min , temp_max, d_temp_min , 
d_temp_max  

 

 

 



- 84 – 

 

 

    4. การประยุกต์ใช้โปรแกรม Arcgis 10.1 เพื่อการพยากรณ์โอกาส 
การเกิดฝนหรือฝนฟ้าคะนองบริเวณภาคตะวันออกเฉียงเหนือตอนบน 
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4.1 การเตรียมข้อมูลน าเข้าด้วยโปรแกรม Microsoft Excel ข้อมูลพยากรณ์พื้นที่เสี่ยงเกิดฝน
ฟ้าคะนอง 

4.1.1  เปิดไฟล์ excel ที่ใช้จัดเก็บข้อมูลค่า KI และ LI 

  4.1.2  กดลิงก์แต่ละสถานี เพื่อเรียกเปิดค่าพยากรณ์ Sounding ตามท่ีตั้งไว้แล้ว 

 
 

4.1.3 คลิก Load Sounding เพ่ือเลือกวันและเวลาที่ต้องการ 
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4.1.4 บันทึกค่า KI และ LI ลงในไฟล์ที่ใช้จัดเก็บค่า และบันทึกในไฟล์ excel 

 

 
 
 

4.1.5 ประเมินโอกาสที่จะเกิดฝนฟ้าคะนอง ลงในคอลัมน์ “TS_forecast” โดยใช้เกณฑ์ดังนี้ 

  
0 = ไม่เกิดฝนหรือฝนฟ้าคะนอง 1 ถึง 2 = 20-40% >2 ถึง 3 = 40-60% 

>3 ถึง 4 = 60-80% >4 ถึง 5 = 80-90%   6 = 100% 
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เกณฑ์การพิจารณา          
K Index (KI)  : Measure of  thunderstorm potential based on 

 - Vertical temperature lapse rate 
 - Moisture content of the lower atmosphere 

 - Vertical extent of the moist layer 

Index Probability of Thunderstorms 

K < 15 0% 

15 to 20 20% 

21 to 25 20 – 40% 

26 to 30 40 – 60% 

31 to 35 60 – 80% 

36 to 40 80 – 90% 

K > 40 Near 100% 

Lifted Index (LI) 
 - Positive = Stable 

 - Negative = Unstable 

 Lifted Index (LI) 

0 to -2 Thunderstorms Possible – Good trigger needed 

-3  to -5 Unstable – Thunderstorms probable 

Less then -5 Very Unstable – Heavy to strong thunderstorm 
potential 
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4.2 การแสดงผลข้อมูลด้วยโปรแกรม ArcGIS 10.1 
 4.2.1 เปิดโปรแกรม ArcGIS 10.1 

4.2.2 เปิดไฟล์ TS_Forecast Project.mxd โดยไฟที่ค าสั่ง 
4.2.3 File -> open -> D:\graphic_forecast\TS_Forecast -> TS_Forecast Project.mxd 
4.2.4 ท าการลบเลเยอร์  ts06jul60 (ชื่อเปลี่ยนตามวันเดือนปี) 
 

 
 

4.2.5 น าเข้าข้อมูลที่ถูกจัดเตรียมไว้แล้วในรูปแบบ excel เพ่ือน ามาแสดงผลในแผนที่ โดยคลิกที่ 
Add data เลือกไฟล์ที่ต้องการ และคลิก Add 
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 4.2.6 เลือกชีทของข้อมูลที่ต้องการให้แสดงผลแล้วคลิก Add 
 

 
 

4.2.7 คลิกขวาที่ Attribute ‘50_met_station’ แล้วเลือก Display XY Data… 
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 4.2.8  จะปรากฏหน้าต่าง Display XY Data…  

ที่ช่อง XField : เลือก ST_LONG 
ที่ช่อง YField : เลือก ST_LAT 
ที่ช่อง ZField : เลือก TS_forecast 
เมื่อเลือกตามขั้นตอนข้างต้นแล้ว คลิก OK 
 

 
 

 
 
 
 
 
 

4.2.9 ท าการลบเลเยอร์ “สถานีตรวจอากาศ” โดยการคลิ๊กขวาแล้วกด remove 
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4.2.10 ดับเบ้ิลคลิกท่ี สญัลักษณ์       ท่ีเลเยอร์ ‘50_met_station$’Events จะปรากฏหน้าต่าง 
Symbol Selector เลือกสัญลักษณ์         และเปลี่ยนตัวเลขในช่อง Size เป็น 30 คลิก OK 
 

 
 

4.2.11 ดับเบ้ิลคลิกท่ีเลเยอร์ ‘50_met_station$’ Events จะปรากฏหน้าต่าง Layer Properties 
เปลี่ยน Layer name เป็น สถานีตรวจอากาศจังหวัด และคลิก OK 
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 4.2.12 ค้นหาค าว่า IDW ที่ช่อง Search แล้วคลิกเลือก IDW (Spatial Analyst) จะปรากฏ 
หน้าต่าง IDW ที่ช่อง Input point features เลือก สถานีตรวจอากาศจังหวัดที่ช่อง Z value fields เลือก 
TS_forecast และคลิกที่ Environments… 

 

 
 

4.2.13 เมื่อคลิกท่ี Environments… จะปรากฏหน้าต่าง Environment settings 
เลือก Processing Extent ที่ช่อง Extent เลือก สถานีตรวจอากาศจังหวัด เลือก Raster Analysis ที่ช่อง Mask 

เลือก ขอบเขตจังหวัด คลิก OK และคลิก OK อีกครั้งที่หน้าต่าง IDW 
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4.2.14 เมื่อได้ผลการประมาณค่าด้วยวิธี IDW แล้ว คลิกขวาที่เลเยอร์ผลการประมาณค่า 
เลือก Properties… 
 

 
 

4.2.15 จะปรากฏหน้าต่าง Layer Properties คลิกสัญลักษณ์            จะปรากฏหน้าต่าง 
Import symbology เลือก label layer ที่สร้างไว้ คลิก Add 
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 4.2.16 จะได้ระดับสีของการพยากรณ์โอกาสเกิดฝน และฝนฟ้าตะนองตามรูปแบบเดิม  
ที่สร้างไว้ 
 

 

 
4.2.17 ดับเบ้ิลคลิกท่ี วนัท่ี ใน Layout จะปรากฏหน้าต่าง Propertie เปลี่ยนวันเดือนปีตาม

ต้องการแล้วคลิก OK 
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4.2.18 ดับเบ้ิลคลิกท่ีกรอบ ค าอธบิายสญัลักษณ์ จะปรากฏหน้าต่าง Legend Properties 
คลิกเลือก idw_met_50 (ชื่อเลเยอร์ผลลัพธ์จากการประมาณค่า)คลิกเครื่องหมาย           และคลิก OK 
 

 
 
 

4.2.19 ท าการลบ Attribute สถานีตรวจอากาศจังหวัดโดยคลิกขวาและกด remove 
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4.2.20 ท าการ Export แผนที่ โดยการคลิก File -> Export Map 
 

 
 

4.2.21 จะปรากฏหน้าต่าง Export Map เลือก Folder ที่ใช้ในการจัดเก็บไฟล์ ตั้งชื่อไฟล์ และ
เลือกประเภทของไฟล์เป็น JPEG (*.jpg)  คลิก Save เพ่ือท าการบันทึกไฟล์ 
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4.2.22  ไฟล์ที่ได้จากการ Export จะถูกจัดเก็บใน Folder ที่เลือกไว้  ผลการจัดท าแผนที่ 
พยากรณ์พ้ืนที่ที่มีโอกาสเกิดฝน และฝนฟ้าคะนอง เป็นดังนี้  

 

 

 

 

 

 

 

 

 

 

 

 



 

- 98 - 

 

 

ผลที่ได้รับ 

1. ได้แลกเปลี่ยนและเพ่ิมพูนความรู้ด้านสารสนเทศภูมิศาสตร์ (GIS) 
2. มีโอกาสต่อยอดองค์ความรู้ที่ได้รับ 
3. มีรูปแบบการผลิตแผนที่ข้อมูลอุตุนิยมวิทยาที่เป็นมาตรฐานเดียวกัน 
4. ได้คู่มือความรู้ด้านสารสนเทศภูมิศาสตร์ (GIS) และการผลิตแผนที่ข้อมูลอุตุนิยมวิทยา 
5. บุคลากรน าความรู้ด้านสารสนเทศภูมิศาสตร์ (GIS) ประยุกต์ใช้กับงานอุตุนิยมวิทยา 
6. ได้นวัตกรรมใหม่ ๆ จากองค์ความรู้ 

 

ข้อเสนอแนะ 

1. ขั้นตอนการจัดท าแผนที่ข้อมูลอุตุนิยมวิทยาควรให้สั้นในใช้เวลาน้อยที่สุดเพ่ือลดระยะเวลาในการ
ท างาน เห็นควรจัดท าเป็นรูปแบบ Model  

2. ควรขยายองค์ความรู้ให้แพร่หลายไปยังสถานีอุตุนิยมวิทยาต่างจังหวัดด้วย 
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